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User Guide (English)

Thank you for purchasing the AIR 192|14. At M-Audio, we know how serious music is to you.
That’s why we design our equipment with only one thing in mind—to make your performance
the best it can be.

Box Contents

AIR 19214

Power Adapter

USB-C to USB-C Cable

USB-C to USB-A Cable

(2) 1/8" (3.5 mm) to MIDI Adapters
Software Download Cards

User Guide

Safety & Warranty Manual

Support

For the latest information about this product (documentation, technical specifications, system
requirements, compatibility information, etc.) and product registration, visit m-audio.com.

For additional product support, visit m-audio.com/support.

Audio Setup

Windows users: Before connecting AIR 192|14 to your computer, install the driver:

1. Go to m-audio.com/drivers and download the latest AIR 192|14 driver for your operating

system.

2. Open the file you downloaded and double-click the driver installer file.

3. Read the End-User License Agreement, then check the box to Agree and click Next to
continue.

4. Click Install to begin the installation. You may be asked to connect AIR 192|14 to your
computer during the installation process. Click Install on any further system messages
during the installation.

5. Once the installation is complete, click Finish.

To use the Windows driver, open the M-Audio AIR 192|14 Control Panel. Here, you can set
your Preferred Buffer Size and Sample Rate.
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To set AIR 192|14 as your default playback device, follow the directions below based on your computer’s
operating system.

Windows:

1.

Use the included USB cable to connect the AIR 192[14 to your computer. Press the power button to
power on AIR 192[14.

2. In the Taskbar, locate the Volume Control "speaker" icon. Right-click the speaker and select Playback
Devices.
Alternatively, go to Start Menu > Control Panel (or Settings > Control Panel in Classic View) >
Hardware and Sound > Sound.

3. In the Windows Sound control panel select the Playback tab and select AIR 192[14 as the default
device.

4. Click the Recording tab and select AIR 192|14 as the default device.

5. Click Properties in the lower right-hand corner.

6. In the new window, click the Advanced tab and select 2-channel, 24-bit, 48000 Hz (Studio Quality) as
the default format.

7. Uncheck both boxes under Exclusive Mode.

8. Click OK to close the Properties window.

9. Click OK to close the Sound control panel.

macOS:

1. Use the included USB cable to connect the AIR 192|14 to your computer. Press the power button to
power on AIR 192|14.

2. Go to Applications > Utilities > Audio MIDI Setup.

3. In the Audio Devices window, select AIR 192|14 in the left column.

4. Right-click AIR 19214, and select Use this device for sound input.

5. Right-click AIR 19214, and select Use this device for sound output.

6. Quit Audio MIDI Setup.

Setting Up AIR 192|14 with Your Software

Setting Up AIR 192|14 with MPC Beats

1.
2.
3.

Use the included USB cable to connect the M-Audio AIR 192|14 to your computer.
Open MPC Beats.
Go to Edit > Preferences....

For Windows Users: In the Audio window, select ASIO under the Audio Device Type dropdown
menu. In the Device dropdown menu, select M-Audio AIR 192[14.

For macOS Users: In the Audio window, select AIR 192[14 under the Output and Input dropdown
menus.

Note: You may need to save and restart your project.
Select your Sample Rate and then click OK to close the Preferences window.

You can now add tracks to send and receive audio from sources connected to M-Audio AIR 192[14
inputs and stream recorded audio back through the M-Audio AIR 192|14 outputs.

Setting Up AIR 192[14 with Ableton Live Lite

SRS

Use the included USB cable to connect the AIR 192|14 to your computer.
Open Ableton Live Lite.

Go to Preferences > Audio tab.

Click on Driver Type to select CoreAudio (Mac) or ASIO (Windows).
Select AIR 192|14 in the Input and Output Config section.

Select your Sample Rate and then close the audio preferences window.

You can now add tracks to send and receive audio and MIDI from sources connected to AIR 192|14 inputs
and stream recorded audio back through the AIR 192|14 outputs.



Connection Diagrams
Items not listed under Introduction > Box Contents are sold separately.
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Top Panel

1.

Power Button: Press this button to power
the AIR 192|14 on or off. The Power LED
below this button lights up when the unit
is powered on.

Input Gain: Adjusts the input's gain level.
Set this knob so the corresponding LED
Meter (located below the knob) displays a
"healthy" level (yellow LED is lit) during
performance—but not so high that the
meter frequently "clips" or peaks (red LED
is lit), causing distortion in the audio.

LED Meters (Inputs 1-6): Indicates the
input signal level from the Combo Inputs
and Instrument Inputs.

LED Meters (Inputs 7-8): Indicates the
input signal level from the Line Inputs.
These LEDs are green when a signal
above -20 dBFS is present, and turn red
when the signal "clips" or peaks.

+48 V (Phantom Power) Switches: These switches activate and deactivate phantom power for
Combo Inputs 1-2 or 3-4. When activated, phantom power supplies +48 volts to the selected
inputs. Please note that most dynamic microphones and ribbon microphones do not require
phantom power, while most condenser microphones do. Consult your microphone's
documentation to find out whether it needs phantom power.

Monitor Level: Adjusts the output volume of Main Outputs, which should be connected to your
powered monitors or amplifier system.

Monitor Mix: Adjusts the mix of the audio signal from your inputs (Direct) and the audio output
of your computer (USB) that will be sent to the Main Outputs and Headphone Outputs.

Note: When set to Direct, the left channel will be a sum of Inputs 1, 3, 5, and 7 and the right
channel will be a sum of Inputs 2, 4, 6, and 8. You can sum these left and right channels (to hear
all inputs as a single summed mono signal) by putting the Direct Monitor button in its
depressed position.

This knob is useful for dealing with "latency" when you are recording in your DAW. Latency is a
delay in sound that may occur between the incoming sound (playing your instrument, singing,
etc.) and outgoing sound (when you hear it in the DAW).

Latency is often the result of the "buffer size" setting, which is usually located in your DAW’s
Preferences, Options, or Device Setup menu. Higher buffer sizes generally result in higher
latency. In some cases, lower buffer size settings can consume a lot of your computer’s CPU
and cause audio glitches. To prevent these audio glitches, you will need to use a higher buffer
setting, and this may result in latency.
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If you are experiencing latency when recording, adjust the knob towards the Direct position to
increase the blend of unprocessed audio from your inputs directly to your Main Outputs and
Headphone Outputs. This will let you hear the incoming audio from your inputs without latency
while still being able to hear the audio from your DAW. When listening to the playback, adjust the
knob all the way to the USB position.

If your computer is powerful enough, you may be able to set the buffer size setting in your DAW
low enough such that you may never need to listen to the direct audio signal from your inputs. In
this case, set the Monitor Mix knob all the way to the USB position to monitor only the audio
output of your DAW.



8. Direct Monitor Selector: Leave this switch in the raised position (blue Stereo LED is lit) to monitor the
direct input signal with Inputs 1, 3, 5, and 7 in the left channel and Inputs 2, 4, 6, and 8 in the right
channel. This is useful if you want to directly monitor a stereo mic setup such as a stereo signal from a
keyboard, or overhead drum mics. Put this switch in its depressed position (green Mono LED is lit) to
monitor the direct input signal with all inputs summed and heard equally on each side. This is useful for
monitoring a guitar or vocal mic signal. This switch does not affect the DAW playback or how your
sound is recorded into your DAW; it affects only how you hear the input signal in the Headphone
Outputs (when the Headphone Source Selector is set to 1/2, and the Monitor Mix is set to anything
besides USB) and Monitor Outputs.

9. Headphone Source Selector: These switches select which outputs (on the rear panel) are also sent to
the Headphone Outputs: Main Outputs 1-2 (1/2) or Outputs 3-4 (3/4).

10. Headphone Outputs (front panel): Connect 1/4" (6.35 mm) TRS headphones to these outputs. The mix
you hear from these outputs will be determined by the Headphone Source Selector, Monitor Mix
knob, Direct Monitor Selector, and associated Headphone Volume knob.

11. Headphone Volume (front panel): Adjusts the output volume of the Headphone Outputs.

12. Instrument Inputs (5-6) (front panel): Connect a guitar with a passive pickup or other high-impedance
signal to these inputs with a 1/4" (6.35 mm) TS cable. View the input signal levels with the LED Meters
(Inputs 5-6).

Rear Panel

1. Power: Connect the included power adapter
to this input. Use the Power Button to turn
AIR 19214 on or off.

2. USB Port (Type C): This connection will
allow you to send audio and MIDI data to and
from a computer. Use the included USB-C-
to-USB-C or USB-C-to-USB-A cables to
connect the AIR 192|14 to a computer. The
AIR 19214 requires a USB 2.0 connection (or
higher).

3. MIDI Out: Use the included 1/8" (3.5 mm)-to-MIDI adapter and a standard five-pin MIDI cable to
connect this MIDI Out to the MIDI In of an external MIDI device (e.g., a synthesizer, sequencer, drum
machine, etc.).

Important: Do not connect audio devices (e.g., headphones, monitors, etc.) to this jack. Use the
included 1/8”-to-MIDI adapter to connect MIDI devices only.

4. MIDI In: Use the included 1/8" (3.5 mm)-to-MIDI adapter and a standard five-pin MIDI cable to connect
this MIDI In to the MIDI Out of an external MIDI device (e.g., a MIDI controller).

Important: Do not connect audio devices (e.g., headphones, monitors, etc.) to this jack. Use the
included 1/8"-to-MIDI adapter to connect MIDI devices only.

5. Outputs (3-4): Use standard 1/4" (6.35 mm) TRS cables to connect these line outputs to a headphone
amplifier, external signal processors like a compressor, etc. Their levels are automatically +4 dBu.

6. Main Outputs (1-2): Use standard 1/4" (6.35 mm) TRS cables to connect these outputs to your
powered monitors, amplifier system, etc. The mix you hear from these outputs will be determined by
the Monitor Mix knob and Direct Monitor button. The level of these ouputs is controlled by the
Monitor Level knob.

7. Line Inputs (7-8): Connect mixers and other line-level devices to these inputs using standard 1/4" (6.35
mm) TRS cables. View the input signal levels with the LED Meters (Inputs 7-8).

8. Combo Inputs (1-4): Connect microphones, a guitar or bass with an active pickup, or line-level devices
to these inputs. For microphones, use an XLR or 1/4" (6.35 mm) TRS cable. For a guitar or bass with an
active pickup, use a standard 1/4" TS cable. For line-level signals, use a 1/4" TRS cable. View the input
signal levels with the LED Meters (Inputs 1-4).

9. Kensington Lock Slot: You can use this Kensington lock slot to secure AIR 192|14 to a table or other

surface.



Guia del usuario (Espanol)

Introduccion

Gracias por comprar el AIR 192|14. En M-Audio, sabemos que usted se toma la musica en serio. Por
eso es que disefamos nuestros equipos con una sola cosa en mente—hacer que pueda tocar su
mejor interpretacion.

Contenido de la caja

AIR 192|14

Adaptador de alimentacion

Cable USB-C a USB-C

Cable USB-C a USB-A

(2) Adaptadores MIDI de 3,5 mm (1/8 pulg.)
Tarjetas de descarga de software

Guia del usuario

Manual sobre la seguridad y garantia

Soporte

Para obtener la informacién mas reciente acerca de este producto (documentacion, especificaciones
técnicas, requisitos de sistema, informacion de compatibilidad, etc.) y registro del producto, visite
m-audio.com.

Para obtener soporte adicional del producto, visite m-audio.com/support.

Instalacion

Ajuste del audio

Usuarios de Windows: Antes de conectar el AIR 192|14 a su ordenador, instale el controlador:

1. Vaya a m-audio.com/drivers y descargue el controlador AIR 192|114 mas reciente
correspondiente a su sistema operativo.

N

Abra el archivo y haga doble clic en el archivo instalador del controlador.

«

Lea el Acuerdo de licencia de usuario final, marque la casilla de Agree (Acepto) y haga clic en
Next (Siguiente) para continuar.

4. Haga clic en Install (Instalar) para comenzar la instalacion. Es posible el sistema le solicite
conectar el AIR 192|14 a su ordenador durante el proceso de instalacion. Haga clic en Install en
respuesta a todos los posibles mensajes adicionales del sistema durante la instalacion.

5. Una vez terminada la instalacién, haga clic en Finish (Terminar).

Para utilizar el controlador de Windows, abra el M-Audio AIR 192|14 Control Panel. Aqui puede
configurar su Preferred Buffer Size (Tamafio de bufer preferido) y la Sample Rate (Frecuencia de
muestreo).

@
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Para configurar el AIR 192|14 como dispositivo de reproduccién predeterminado, siga las
indicaciones que se incluyen a continuacién sobre la base del sistema operativo de su ordenador.

Windows:

1.

Utilice el cable USB incluido para conectar el AIR 192|14 a su ordenador. Pulse el botén de
encendido para encender el AIR 192|14.

2. Localice en la barra de tareas el icono del "altavoz" del control de volumen. Haga clic derecho
en el altavoz y seleccione Playback Devices (Dispositivos de reproduccion).

Como alternativa, haga clic en Start Menu (menu Inicio) > Control Panel (Panel de control) (o
Settings [Ajustes] > Control Panel en la Vista clasica) > Hardware and Sound (Hardware y
sonido) > Sound (Sonido).

3. En el panel de control Windows Sound (Sonido de Windows), seleccione la pestafa Playback
(Reproduccion) y seleccione AIR 192|14 como dispositivo predeterminado.

4. Haga clic en la pestafia Recording (Grabacién) y seleccione AIR 192|14 como dispositivo
predeterminado.

5. Haga clic en Properties (Propiedades) en la esquina inferior derecha.

6. En la nueva ventana, haga clic en la pestana Advanced (Avanzadas) y seleccione 2-channel,
24-bit, 48000 Hz (Studio Quality) (2 canales, 24 bits, 48000 Hz, calidad de estudio) como
formato predeterminado.

7. Deshaga la seleccion de las dos casillas que estan bajo Exclusive Mode (Modo exclusivo).

8. Haga clic en OK (Aceptar) para cerrar la ventana de propiedades.

9. Haga clic en OK (Aceptar) para cerrar el panel de control de sonido.

macOS:

1. Utilice el cable USB incluido para conectar el AIR 192|14 a su ordenador. Pulse el botén de
encendido para encender el AIR 192|14.

2. Vaya a Applications > Utilities > Audio MIDI Setup (Aplicaciones > Utilidades > Configuracion
MIDI de audio).

3. En la ventana Audio Devices (Dispositivos de audio), seleccione AIR 192[14 en la columna
izquierda.

4. Haga clic derecho en AIR 192|14 y seleccione Use this device for sound input (Utilizar este
dispositivo para la entrada de sonido).

5. Haga clic derecho en AIR 192|14 y seleccione Use this device for sound output (Utilizar este
dispositivo para la salida de sonido).

6. Salga de la configuraciéon MIDI de audio.



Configuracion del AIR 192|14 con su software

Instalacion del AIR 192|14 con MPC Beats:

1. Utilice el cable USB incluido para conectar el AIR 192|14 a su ordenador.
2. Abra MPC Beats.

3. Vaya a Edit > Preferences....

4.

Para usuarios de Windows: En la ventana de audio, seleccione ASIO dentro del menu
desplegable Audio Device Type. Dentro del ment desplegable Device, seleccione AIR 192]14.

Para usuarios de macOS: En la ventana Audio, seleccione AIR 192|14 dentro de los menus
desplegables Output e Input.

Nota: Es posible que tenga que guardar y reiniciar su proyecto.

5. Seleccione su Sample Rate (Tasa de muestreo) y luego haga clic en OK para cerrar la ventana
Preferencias. Ahora puede agregar pistas para enviar y recibir audio desde fuentes conectadas a
las entradas del AIR 192|14 y transmitir audio grabado de regreso a través de las salidas del AIR
192|14.

Para configurar el AIR 192[14 con Ableton Live Lite

Use el cable USB incluido para conectar el AIR 192|14 a su ordenador.

Abra Ableton Live Lite.

Vaya a la pestafia Preferencias > Audio.

Haga clic en Tipo de controlador para seleccionar CoreAudio (Mac) o ASIO (Windows).
Seleccione AIR 192|14 en la seccién Configuracién de entrada y salida.

IS

Seleccione su tasa de muestreo y luego cierre la ventana de preferencias de audio.

Ahora puede afnadir pistas para enviar y recibir audio y MIDI desde las fuentes conectadas a las
entradas del AIR 192|14 y transmitir el audio grabado de regreso por las salidas del AIR 192|14.



Diagramas de conexién

Los elementos que no se enumeran en Introduccion > Contenido de la caja se venden por separado.

Ejemplo 1
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Caracteristicas

Panel superior

1.

Boton Power: Pulse este botén para
encender o apagar el AIR 192[14. El LED
de encendido debajo de este botén se
ilumina cuando se enciende la unidad.

Input Gain: Ajusta el nivel de ganancia de
la entrada. Ajuste esta perilla de manera

que el LED medidor correspondiente

(ubicado debajo de la perilla) muestre un -

nivel "saludable" (se enciende el LED = s — —

amarillo) durante la ejecucion—pero no e e

tan alto que el medidor "recorte” o llegue 8 """" @ g @

al pico a menudo (se enciende el LED

rojo), causando distorsiones en el audio. M-AUDIO 19214

Medidores LED (Entradas 1-6): Indica el ® e
voLume VoLuwe. ¢ Che=

nivel de la sefial de entrada proveniente S — Y
de las entradas combinadas y entradas m m @ @

de instrumentos.

Medidores LED (Entradas 7-8): Indica el nivel de la sefial de entrada proveniente de las entradas de
linea. Estos LED se iluminan de color verde cuando hay una sefial presente que supere los -20 dBFS y
se iluminan de color rojo cuando la sefal "se recorta" o llega el pico.

Interruptores de +48 V (Phantom Power): Estos interruptores activan y desactivan la potencia
fantasma de las entradas combinadas 1-2 o 3-4. Cuando se activa, la alimentacién fantasma
suministra +48 V a las entradas seleccionadas. Tenga en cuenta que los micréfonos dindmicos y de
cinta no requieren alimentacion fantasma, mientras que la mayoria de los micréfonos de condensador
la requieren. Consulte la documentacion de su micréfono para averiguar si necesita alimentacion
fantasma.

Nivel de monitoreo: Ajusta el volumen de salida de las salidas salidas principales (Main Outputs), las
cuales deberian estar conectadas a monitores alimentados o a un sistema de amplificacion.

Monitor Mix: Ajusta la mezcla de la sefial de audio proveniente de sus entradas (Direct) y la salida de
audio de su ordenador (USB) que se enviara a las salidas principales y a las salidas para auriculares.

Nota: Al ajustarse a Direct, el canal izquierdo sera la suma de las entradas 1, 3, 5y 7 y el canal
derecho sera la suma de las entradas 2, 4, 6 y 8. Puede sumar estos canales izquierdo y derecho (para
escuchar todas las entradas como una sefial mono individual sumada) colocando el botén Direct
Monitor en su posicion hacia abajo.

Esta perilla es util para lidiar con la "latencia” cuando estd grabando en su DAW. La latencia es el
retardo que puede ocurrir entre el sonido entrante (cuando toca su instrumento, canta, etc.) y el sonido
saliente (cuando lo oye en la DAW).

La latencia es a menudo el resultado del ajuste del "tamafo del bufer", el cual suele estar ubicado en
los menus de preferencias, opciones o configuracién de dispositivo de su DAW. Los tamafios de bufer
mas grandes generalmente producen mayores latencias. En algunos casos, ajustes mas bajos del
tamafio del bufer pueden consumir una gran cantidad de recursos de la CPU de su ordenador y causar
defectos en el audio. Para prevenir estos defectos, debera utilizar un ajuste mayor del bufer, y esto
podria crear latencia como resultado.

Si esta experimentando latencia al grabar, ajuste la perilla hacia la posicion Direct para aumentar la
mezcla de audio sin procesar que proviene de sus entradas directamente a las salidas principales y
las salidas para auriculares. Esto le permitird escuchar el audio entrante proveniente de sus entradas
sin la latencia a la vez que escucha el audio proveniente de su DAW. Cuando escuche la reproduccion,
gire la perilla totalmente a la posiciéon USB.

Si su ordenador es lo suficientemente potente, podra ajustar el tamafio del buffer en su DAW lo
suficientemente bajo como para nunca mas tener que escuchar la sefial de audio directa proveniente
de sus entradas. En este caso, gire la perilla de mezcla Monitor Mix totalmente hacia la posicién USB
para monitorizar solo la salida de audio de su DAW.



10.

11.
12.

Selector de Direct Monitor: Deje este interruptor en posicion levantada (LED Stereo azul encendido) para
monitorizar la sefial de entrada directa con las entradas 1, 3, 5y 7 en el canal izquierdo y las entradas 2, 4,6 y
8 en el canal derecho. Esto resulta de utilidad si desea monitorizar directamente una instalaciéon con
micréfonos en estéreo, como por ejemplo una sefial estéreo proveniente de un teclado o de micréfonos
colgantes para baterias. Coloque este interruptor en posicion hacia abajo (el LED Mono se enciende) para
monitorizar la sefial de la entrada directa con todas las entradas sumadas y oyéndose por igual en cada lado.
Esto resulta de utilidad para monitorizar la sefial de una guitarra de un micréfono de voz. Este interruptor no
afecta a la reproduccién de la DAW o la forma en que se graba su sonido en su DAW; afecta solo a la manera
en que usted oye su sefial de entrada en las salidas para auriculares (cuando el selector de fuente de
auriculares se ajusta a 1/2 y Monitor Mix se ajusta cualquier valor menos USB) y en las salidas de
monitorizacion.

Selector de fuente de auriculares: Estos interruptores seleccionan cudles salidas (del panel trasero) son
enviadas también a las salidas para auriculares: Las salidas principales 1-2 (1/2) o las salidas 3-4 (3/4).

Salida para auriculares (panel frontal): Conecte a estas salidas auriculares TRS de 6,35 mm (1/4 pulg). La
mezcla que escucha a través de estas salidas es determinada por el selector de fuente de auriculares, la
perilla Monitor Mix, el selector Direct Monitor y la perilla de volumen de auriculares asociada.

Volumen para auriculares (panel frontal): Ajusta el volumen de salida de las salidas para auriculares.

Entradas de instrumentos (5-6) (panel frontal): Conecte a estas entradas una guitarra con captador pasivo u
otra sefial de alta impedancia mediante un cable TS de 6,35 mm (1/4 pulg.). Vea los niveles de la sefial de
entrada con los medidores LED (entradas 5-6).

Panel trasero

Suministro eléctrico: Conecte a esta
entrada el adaptador de corriente incluido.
Pulse el boton de encendido para encender
o apagar el AIR 192[14.

Puerto USB (tipo C): Esta conexion le
permitird enviar audio y datos MIDI hacia o
desde un ordenador. Utilice los cables
USB-C-a-USB-C o USB-C-a-USB-A para
conectar el AIR 19214 a un ordenador. El
AIR 192|14 requiere una conexion USB 2.0 (o
superior).

Salida MIDI: Utilice el adaptador MIDI de 3,5 mm incluido y un cable MIDI estandar de cinco patillas para
conectar esta salida MIDI a la entrada MIDI de un dispositivo MIDI externo (por ejemplo, un sintetizador,
secuenciador, caja de ritmos, etc.).

192114
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Importante: No conecte dispositivos de audio (como auriculares, monitores, etc.) a esta salida. Use el
adaptador MIDI de 3,5 mm incluido para conectar sélo dispositivos MIDI.

Entrada MIDI: Utilice el adaptador MIDI de 3,5 mm incluido y un cable MIDI estandar de cinco patillas para
conectar esta entrada MIDI a la salida MIDI de un dispositivo MIDI externo (por ejemplo, un controlador MIDI).

Importante: No conecte dispositivos de audio (como auriculares, monitores, etc.) a esta entrada. Use el
adaptador MIDI de 3,5 mm incluido para conectar sélo dispositivos MIDI.

Salidas 3-4: Utilice cables TRS estandar de 6,35 mm (1/4 pulg.) para conectar estas salidas de linea a un
amplificador para auriculares o a procesadores de sefial externos tales como compresores, etc. Sus niveles
son automaticamente +4 dBu.

Salidas principales (1-2): Utilice cables TRS estandar de 6,35 mm (1/4 pulg.) para conectar estas salidas a sus
monitores alimentados, sistema de amplificacion, etc. La mezcla que escuche por estas salidas es determinada
por la perilla Monitor Mix y el botén Direct Monitor. El nivel de estas salidas esta controlado por la perilla
nivel de monitoreo.

Entradas de linea (7-8): Conecte mezcladores y otros dispositivos de nivel de linea a estas entradas utilizando
cables TRS estandar de 6,35 mm (1/4 pulg.). Vea los niveles de la sefial de entrada con los medidores de LED
(entradas 7-8).

Entradas combinadas (1-4): Conecte a estas entradas micréfonos, una guitarra o bajo con captador activo o
dispositivos de nivel de linea. Para micréfonos, utilice un cable XLR o TRS de 6,35 mm (1/4 pulg.). Para
guitarras o bajos con captador activo, utilice un cable TS estandar de 1/4 pulg. Para sefiales de nivel de linea,
utilice un cable TRS de 1/4 pulg. Vea los niveles de la sefial de entrada con los medidores de LED (entradas
1-4).

Ranura de bloqueo Kensington: Puede utilizar esta ranura de bloqueo Kensington a fin de sujetar el AIR
192|14 a una mesa u otra superficie.



Guide d'utilisation (Francais)

Merci d’avoir fait I'acquisition de I'AIR 192|14. Chez M-Audio, nous savons a quel point la musique
est importante pour vous. C’est pourquoi nous concevons nos produits avec une seule chose en
téte — faire de votre performance la meilleure qui soit.

Contenu de la boite

AIR 192|14

Adaptateur d'alimentation

Cable USB-C a USB-C

Céble USB-C a USB-A

(2) Adaptateurs MIDI a 3,5 mm (1/8 po)
Cartes de téléchargement de logiciel
Guide d'utilisation

Consignes de sécurité et informations concernant la garantie

Assistance

Pour les toutes derniéres informations concernant la documentation, les spécifications techniques, la
configuration requise, la compatibilité et I'enregistrement du produit, veuillez visiter m-audio.com.

Pour de |'assistance supplémentaire, veuillez visiter m-audio.com/support.

Démarrage

Parameétres audio

Utilisateurs Windows : Avant de brancher I'AIR 192|14 & votre ordinateur pour la premiére fois, vous
devez installer le pilote :

1. Veuillez visiter m-audio.com/drivers et télécharger la derniére version du pilote AIR 192|14 pour
votre systéme d'exploitation.

2. Ouvrez le fichier téléchargé, puis double-cliquez sur le fichier d'installation du pilote.
Veuillez lire le contrat de licence, cocher « J'accepte » et cliquer sur Suivant.

Cliquez sur Installer pour lancer I'installation. Il se peut que vous soyez invité a brancher I'AIR
192|14 a votre ordinateur durant I'installation. Cliquez sur Installer sur tous les autres messages
systéme pendant I'installation.

5. Lorsque I'installation est terminée, cliquez sur Terminer.

Pour utiliser le pilote Windows, ouvrez le Control Panel de I'AIR 19214 de M-Audio. Vous pouvez
définir la taille de la mémoire tampon et la fréquence d’échantillonnage a partir de cette fenétre.


http://www.m-audio.com
http://www.m-audio.com/support
http://www.m-audio.com/drivers

Pour définir I'AIR 19214 comme périphérique de lecture par défaut, veuillez suivre les instructions ci-
dessous, selon le systéme d'exploitation de votre ordinateur.

Windows :

1.

Utilisez le cable USB inclus pour brancher I'AIR 19214 & votre ordinateur. Appuyez sur
I'interrupteur d'alimentation pour mettre I'AIR 192|14 sous tension.

2. Dans la barre des taches, recherchez I'icone de la commande de volume (haut-parleur). Faites
un clic droit sur I'icone du haut-parleur et sélectionnez Périphériques de lecture.
Vous pouvez également cliquer sur Démarrer > Panneau de configuration (ou Paramétres >
Panneau de configuration en Affichage classique) > Matériel et audio > Son.

3. Dans le panneau de configuration Son, sélectionnez I'onglet Lecture, puis sélectionnez AIR
192|14 comme le périphérique par défaut.

4. Cliquez sur I'onglet Enregistrement et sélectionnez AIR 192|14 comme appareil par défaut.

5. Cliquez sur Propriétés dans le coin inférieur droit.

6. A partir de la nouvelle fenétre, cliquez sur I'onglet Advancé et sélectionnez I'option 2 canaux, 24
bits, 48 000 Hz (Qualité CD) comme le format par défaut.

7. Décochez les deux options sous Mode exclusif.

8. Cliquez OK pour fermer la fenétre Propriétés.

9. Cliquez OK pour fermer le panneau de configuration Son.

macOS :

1. Utilisez le cable USB inclus pour brancher I'AIR 19214 a votre ordinateur. Appuyez sur
I'interrupteur d'alimentation pour mettre I'AIR 192|14 sous tension.

2. Allez a Applications > Utilitaires > Configuration audio et MIDI.

3. Dans la fenétre Périphériques audio qui s'affiche, sélectionnez AIR 192|14 dans la fenétre de
gauche.

4. Faite un clic droit sur AIR 192|14 et sélectionnez Utiliser ce périphérique pour I'entrée audio.

5. Faite un clic droit sur AIR 192|14 et sélectionnez Utiliser ce périphérique pour la sortie audio.

6. Quitter le menu de Configuration audio et MIDI.



Configuration de I'AIR 192|14 pour votre logiciel

Installation de AIR 192|14 avec MPC Beats :

Ao~

Utilisez le cable USB fourni pour brancher I'interface AIR 192|14 a votre ordinateur.
Lancez MPC Beats.
Cliquez sur Edit > Preferences....

Pour les utilisateurs Windows : Dans la fenétre Audio, sélectionnez ASIO dans le menu
déroulant Audio Device Type. Dans le menu déroulant Device, sélectionnez AIR 192]|14.

Pour les utilisateurs de macOS : Dans la fenétre Audio, sélectionnez AIR 192|14 dans les
menus déroulants Output et Input.

Remarque : Il se peut que vous ayez a sauvegarder et a redémarrer votre projet.

Sélectionnez le taux d’échantillonnage dans le champ Sample Rate, puis cliquez sur OK pour
fermer la fenétre des préférences.

Vous pouvez maintenant ajouter des pistes pour transmettre et recevoir de I'audio a partir de
sources reliées aux entrées de I'AIR 192|14 et retransmettre I'audio enregistré via les sorties de
PAIR 192|14.

Pour configurer I'AIR 192|14 pour Ableton Live Lite

1.

2
3
4.
5
6

Utilisez le cable USB fourni pour brancher I'AIR 192|14 & un ordinateur.

Lancez Ableton Live Lite.

Cliquez sur I'onglet Preferences > Audio.

Cliquez sur Driver Type pour sélectionner CoreAudio (Mac) ou ASIO (Windows).
Sélectionnez AIR 192|14 dans les sections de configuration des entrées et des sorties.

Sélectionnez la fréquence d’échantillonnage, puis fermez la fenétre des préférences audio.

Vous pouvez maintenant ajouter des pistes et recevoir un signal audio et des messages MIDI des
sources branchées aux entrées de I'AIR 192|14 et transmettre en continu des fichiers par le biais des
sorties de I'AIR 192|14.



Schéma de connexion

Les éléments qui ne figurent pas dans Présentation > Contenu de la boite sont vendus séparément.
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Caractéristiques

Panneau supérieur

1. Touche d'alimentation: Cette touche
permet de mettre I'AIR 192|14 sous et hors
tension. La DEL d'alimentation située sous
cette touche s'allume lorsque |'appareil est
sous tension.

=Y

2. Gain d'entrée : Ces boutons permettent
d'ajuster le niveau de gain du signal d'entrée.
Réglez ce bouton afin que le vumeétre a DEL
(sous le bouton) correspondant affiche un
niveau raisonnablement élevé (DEL jaune
allumée), mais sans que le vumeétre indique
de I'écrétage (DEL rouge allumée) afin de ne
pas ajouter de distorsion dans le signal.

3. Vumetres DEL (entrées 1-6) : Ces DEL

4
Cl==}

an

/7
indiquent le niveau du signal d'entrée des ®7m7m7® ®

entrées combo et des entrées d'instrument.

4. Vumeétres a DEL (entrées 7-8) : Ces DEL indiquent le niveau du signal d'entrée des entrées ligne. Ces
DEL sont vertes lorsqu'un signal au-dessus de 20 dBFS est présent et deviennent rouges en présence
d'écrétage.

5. Sélecteurs +48 V (Phantom Power) : Ces sélecteurs permettent d'activer et de désactiver
I'alimentation fantéme des entrées combo 1-2 et 3-4. Lorsqu'elle est activée, I'alimentation fantéme
fournit +48 volts aux entrées sélectionnées. Veuillez noter que la plupart des microphones
électrodynamiques et microphones a ruban ne nécessitent pas d'alimentation fantéme, alors que les
microphones a condensateur en ont besoin. Veuillez consulter la documentation fournie avec votre
microphone pour savoir si vous devez utiliser |'alimentation fantéme.

6. Bouton moniteur : Ce bouton permet de régler le volume des sorties principales reliées a des
moniteurs amplifiés ou a un systéme d'amplification.

7. Monitor Mix: Ce bouton permet d'ajuster le mélange du signal des entrées (Direct) et de la sortie
audio de I'ordinateur (USB) qui sera transmis aux sorties principales et a la sortie casque.

Remarque : En mode Direct, le canal gauche sera un mix des entrées 1, 3, 5 et 7 et le canal droit sera
un mix des entrées 2, 4, 6 et 8. Vous pouvez combiner les canaux gauche et droit afin d'entendre
toutes les entrées comme un seul signal mono en enfongant la touche Direct Monitor.

Ce bouton est utile afin de régler des problémes de latence lors de I'enregistrement sur votre logiciel
audionumérique. La latence est définie comme le délai entre le signal entrant (lorsque vous jouez d'un
instrument, vous chantez, etc.) et le signal sortant (que vous entendez dans votre logiciel
audionumérique).

La latence est souvent reliée au réglage de la taille de la mémoire tampon, qui se trouve habituellement
dans le menu des préférences, des options ou des parameétres de votre logiciel. Généralement, plus la
taille de la mémoire tampon est grande, plus grande sera la latence. Dans certains cas, une taille de
mémoire tampon plus petite peut consommer une grande partie des ressources du processeur et
causer des problemes audio. Pour éviter ces problémes audio, vous devrez utiliser une taille de
mémoire tampon plus élevée, et cela pourrait produire de la latence.

Si vous éprouvez des délais de latence lors de I'enregistrement, essayez d'ajuster le réglage du bouton
vers la position Direct afin d'augmenter la quantité du signal audio non traité transmis des entrées vers
les sorties principales et la sortie casque. Cela vous permettra d'entendre le signal audio sans
latence provenant des entrées tout en pouvant entendre I'audio de votre logiciel. Lors de la lecture,
réglez le bouton sur la position USB.

Si votre ordinateur est assez puissant, vous pourriez peut-étre diminuer le réglage de la taille de la
mémoire tampon de votre logiciel de maniére a ne jamais avoir besoin d'écouter le signal audio
directement des entrées. Si tel est le cas, réglez le bouton Monitor Mix a la position USB afin de
contréler uniqguement la sortie audio de votre logiciel audionumérique.



10.

11.
12.

Sélecteur Direct Monitor : Laissez cette touche désactivée (DEL Stereo bleue sera allumée) pour contrbler le
signal d'entrée direct des entrées 1, 3, 5 et 7 du canal gauche et des entrées 2, 4, 6 et 8 du canal droit. Ceci
est utile lorsque vous souhaitez contréler directement un signal microphone stéréo, comme un signal stéréo
provenant d'un clavier ou de microphones stéréo suspendus pour batterie. Activez cette touche (DEL Mono
verte sera allumée) afin de contrdler le signal d'entrée direct de toutes les entrées combinées reparti également
entre les deux canaux. Ceci est utile lorsque vous souhaitez contréler un signal provenant d'une guitare avec
micros ou d'un microphone pour voix. Ce sélecteur n'affecte pas la lecture du logiciel audionumérique, ou
comment le son est enregistré par le logiciel, il affecte uniquement la fagon dont le son est acheminé aux
sorties casque (lorsque le sélecteur de source casque est réglé sur 1/2 et que le bouton Monitor Mix n'est
pas réglé sur USB) et les sorties moniteur.

Sélecteur de source casque : Ces sélecteurs permettent de choisir quelles sorties (du panneau arriére) sont
également envoyées a la sortie casque : Sorties moniteur 1-2 (1/2) ou sorties 3-4 (3/4).

Sorties casque (panneau avant) : Ces sorties permettent de brancher un casque d'écoute TRS 6,35 mm
stéréo. Le mix que vous entendez via ces sorties est déterminé par le sélecteur de source casque, le bouton
Monitor Mix, le sélecteur Direct Monitor et le bouton volume casque correspondant.

Volume casque (panneau avant) : Ces boutons permettent d'ajuster le niveau des sorties casque.

Entrées instrument (5-6) (panneau avant): Ces entrées permettent de brancher une guitare avec micros
passifs ou un autre instrument a haute impédance avec un céble TS 6,35 mm. Vous pouvez vérifier le niveau du
signal d'entrée sur les vumeétres a DEL (entrées 5-6).

Panneau arriére

Entrée d'alimentation : Cette entrée permet de
brancher I'adaptateur secteur fourni. Utilisez la
touche d'alimentation afin de mettre I'AIR
192|14 sous et hors tension.

Port USB (type C) : Cette connexion permet de
transmettre et de recevoir des signaux audio et
des données MIDI vers et depuis un ordinateur.
Utilisez le cable USB-C-vers-USB-C ou USB-
C-vers-USB-A fourni pour brancher I'AIR
19214 a un ordinateur. L'AIR 192|14 requiert
une connexion USB 2.0 (ou version ultérieure).

Sortie MIDI : Vous pouvez brancher I'adaptateur MIDI & 3,5 mm inclus et un cable MIDI a cing broches
standard a cette sortie et a I'entrée MIDI d'un appareil MIDI externe, comme un synthétiseur, un séquenceur, un
module de percussion, etc.

Important : Ne pas brancher les appareils audio (p. ex., casque d'écoute, moniteur, etc.) a cette sortie. Utilisez
I'adaptateur MIDI a 3,5 mm pour brancher les appareils MIDI seulement.

Entrée MIDI : Vous pouvez brancher |'adaptateur MIDI a 3,5 mm inclus et un céble MIDI a cing broches
standard a cette entrée et a la sortie MIDI d'un appareil MIDI externe, tel un contréleur MIDI.

Important : Ne pas brancher les appareils audio (p. ex., casque d'écoute, moniteur, etc.) a cette entrée. Utilisez
I'adaptateur MIDI a 3,5 mm pour brancher les appareils MIDI seulement.

Sorties (3-4) : Utilisez des cables TRS de 6,35 mm standards pour raccorder ces sorties ligne aux entrées d'un
amplificateur de casque, un processeur de signaux externe comme un compresseur, etc. Le niveau de ces
sorties est de +4 dBu.

Sorties principales (1-2) : Utilisez des cébles TRS 6,35 mm standards pour relier ces sorties a vos moniteurs
amplifiés, a un systeme d'amplification, etc. Le mix que vous entendez via ces sorties est déterminer par les
boutons Monitor Mix et Direct Monitor. Le niveau de ces sorties est commandé par le bouton du volume
moniteur.

Entrées ligne (7-8) : Ces entrées permettent de brancher des consoles de mixage et autres appareils a niveau
ligne a I'aide d'un cable TRS 6,35 mm. Vous pouvez vérifier le niveau du signal d'entrée sur les vumeétres a
DEL (entrées 7-8).

Entrées combo (1-4) : Ces entrées permet de brancher un microphone, une guitare ou une basse avec un
micro actif, ou un appareil a niveau ligne. Pour brancher un microphone, utilisez un cable XLR ou TRS 6,35 mm.
Pour une guitare ou une basse dotée d'un micro actif, utilisez un cable TS 6,35 mm standard. Pour brancher un
appareil a niveau ligne, utilisez un cable TRS 6,35 mm. Vous pouvez vérifier le niveau du signal d'entrée sur les
vumetres a DEL (entrées 1-4).

Verrou Kensington : Cet emplacement permet d'utiliser un verrou Kensington pour sécuriser I'AIR 19214 sur
une table ou autre surface.



Guida per l'uso (Italiano)

Introduzione

Grazie per aver acquistato il AIR 192|14. Noi di M-Audio sappiamo che per te la musica & una cosa
seria. Ecco perché progettiamo i nostri dispositivi con un unico obiettivo in mente: rendere le tue
prestazioni le migliori possibili.

Contenuti della confezione

AIR 192[14

Adattatore di alimentazione

Cavo USB-C a USB-C

Cavo USB-C a USB-A

(2) Adattatori 3,5 mm a MIDI
Schede di download del software
Guida per I'uso

Istruzioni di sicurezza e garanzia

Assistenza

Per le ultime informazioni in merito a questo prodotto (documentazione, specifiche tecniche, requisiti
di sistema, informazioni sulla compatibilita, ecc.) e per effettuarne la registrazione, recarsi alla pagina
m-audio.com.

Per ulteriore assistenza sul prodotto, recarsi alla pagina m-audio.com/support.

Configurazione

Configurazione audio

Utenti Windows: Prima di collegare I'AIR 192|14 al computer, installare il driver:

1. Recarsi alla pagina m-audio.com/drivers e scaricare il driver di AIR 192|14 piu recente per il
proprio sistema operativo.

Aprire il file scaricato e fare doppio clic sull'applicazione di installazione del driver.

Leggere il contratto di licenza per I'utente finale, spuntare la casella per acconsentire e cliccare
su next per proseguire.

w N

4. Cliccare su Install per avviare I'installazione. Durante l'installazione potra essere richiesto di
collegare I'AIR 192|14 al computer. Cliccare su Install in occasione di ulteriori messaggi di
sistema durante I'installazione.

5. Una volta completata I'installazione, cliccare su Finish (fine).
Per utilizzare il driver Windows, aprire il pannello di controllo M-Audio AIR 192|14 Control Panel.

Qui & possibile configurare la Preferred Buffer Size (dimensione del buffer) e la Sample Rate
(frequenza di campionamento).


http://www.m-audio.com/drivers
http://www.m-audio.com/support
http://www.m-audio.com

Per configurare 'AIR 192|114 come dispositivo di riproduzione predefinito, seguire le indicazioni
seguenti, basandosi sul proprio sistema operativo.

Windows:

1.

Servirsi del cavo USB in dotazione per collegare I’AIR 192|14 al computer. Premere il tasto di
alimentazione per accendere il AIR 192|14.

2. Nella Barra delle applicazioni, individuare l'icona "Speaker" di controllo del Volume. Fare clic
col tasto destro del mouse e selezionare Dispositivi di riproduzione.
Cliccare sul menu Start > Pannello di controllo (o Impostazioni > Pannello di controllo nella
vista Classica) > Hardware e suoni > Suoni.

3. Nel pannello di controllo Audio di Windows selezionare la scheda Riproduzione e selezionare
I’AIR 192]|14 come dispositivo predefinito.

4. Cliccare sulla scheda Registrazione e selezionare I'AIR 192|14 come periferica predefinita.
Cliccare su Proprieta nell’angolo inferiore destro.
Nella nuova finestra, cliccare sulla scheda Avanzate e selezionare 2 canali, 24-bit, 48000 Hz
(qualita da Studio) come formato predefinito.

7. Togliere il segno di spunta da entrambe le caselle in Modalita esclusiva.

8. Cliccare su OK per chiudere la finestra Proprieta.

9. Cliccare su OK per chiudere il pannello di controllo Audio.

macOS:

1. Servirsi del cavo USB in dotazione per collegare I’AIR 192|14 al computer. Premere il tasto di
alimentazione per accendere il AIR 192[14.

2. Recarsi su Applicazioni > Utilita > Audio MIDI Setup.
Nella finestra Audio Devices (dispositivi audio), selezionare AIR 192[14 nella colonna sinistra.

4. Fare clic col tasto destro su AIR 192|14 e selezionare Use this device for sound input (utilizza
questo dispositivo per ingresso audio).

5. Fare clic col tasto destro su AIR 192|14 e selezionare Use this device for sound output (utilizza
questo dispositivo per uscita audio).

6. Lasciare Audio Midi Setup.
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Configurazione dell’AIR 192|14 con il Software

Configurazione dell’AIR 192|14 con MPC Beats:

1.

2.
3.
4

Servirsi del cavo USB in dotazione per collegare I'AIR 192[14 al computer.
Aprire MPC Beats.
Recarsi su Edit > Preferences....

Per utenti Windows: Nella finestra Audio, selezionare ASIO nel menu a discesa Audio Device
Type. Nel menu a discesa Device selezionare AIR 192|14.

Per utenti macOS: Nella finestra Audio, selezionare AIR 192[14 sotto i menu a discesa Output e
Input.

Nota bene: pud essere necessario salvare e riavviare il progetto.
Selezionare la Sample Rate e quindi fare clic su OK per chiudere la finestra Preferences.

E ora possibile aggiungere tracce per inviare e ricevere audio dalle fonti collegate agli ingressi
dell’AIR 192|14 e inviare lo streaming dell’audio registrato attraverso le uscite dell’AIR 192[14.

Per configurare I'AIR 192|14 con Ableton Live Lite

I

6.

Servirsi del cavo USB in dotazione per collegare I'AIR 192|14 al computer.

Aprire Ableton Live Lite.

Recarsi alla scheda Preferences (preferiti) > Audio.

Cliccare su Driver Type (tipo di driver) per selezionare CoreAudio (Mac) o ASIO (Windows).
Selezionare AIR 192|14 nella sezione Input e Output Config.

Selezionare Sample Rate e chiudere la finestra delle preferenze audio.

E ora possibile aggiungere tracce per inviare e ricevere audio e MIDI dalle fonti collegate agli ingressi
dell’AIR 192[14 e inviare lo streaming dell’audio registrato attraverso le uscite dell’AIR 192|14.
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Schemi di collegamento
Elementi non elencati sotto Introduzione > Contenuti della confezione sono venduti separatamente.
Esempio 1

Monitor Microfoni
alimentati icrotont Pannello

] superiore/anteriore

Chitarre
elettriche

Cuffie

Pannello
Alimentazione POSteriore

Esempio 2
Monitor . .
Computer alimentati Microfoni Pannelio
T 2 superiore/anteriore )
!‘ @p 7 ' o Chitarre
[ ¢ 000C elettriche

2

Pannello
posteriore ||

Amp cuffie
Esempio 3
Monitor Microfono
alimentati Pannello
Computer iy )

superiore/anteriore
Chitarre
elettriche

Alimentazione X
Dispositivi
MIDI

Pannello
posteriore
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Caratteristiche

Pannello superiore

1.

24

Tasto Power: premere questo tasto per
accendere e spegnere I'AIR 192|14. Il LED
di alimentazione al di sotto del tasto si
accende quando si accende |'apparecchio.

Gain d'ingresso: regola il livello di
guadagno degli ingressi. Impostare questa
manopola in modo che il corrispondente
misuratore LED (situato sotto la manopola)
mostri a display un livello "sano" (LED giallo
acceso) durante le esibizioni, ma non un
livello tale da provocare frequenti "salti" o
picchi (LED rosso acceso), causando
distorsione dell'audio.

Misuratori LED (Ingressi 1-6): Indica il
livello del segnale di ingresso dagli Ingressi
Combo e dagli Ingressi Strumento.

Misuratori LED (ingressi 7-8): indicano il livello di segnale di ingresso proveniente dagli Ingressi di
linea. Questi LED sono verdi quando & presente un segnale al di sopra di -20 dBFS e diventano rossi
quando il segnale presenta “salti” o picchi.

Interruttori +48 V (Phantom Power): questi interruttori attivano e disattivano I'alimentazione phantom
per gli Ingressi combo 1-2 0 3-4. Quando attivata, I’alimentazione phantom fornisce +48 V a entrambi
gli ingressi selezionati. Va notato che i microfoni dinamici e i microfoni a nastro non richiedono
alimentazione phantom, mentre la maggior parte dei microfoni a condensatore si. Consultare la
documentazione del microfono per scoprire se necessita di alimentazione phantom o meno.

Monitor Level: regola il volume di uscita delle uscite principali, che dovrebbero essere collegate ai
monitor o al sistema di amplificazione.

Monitor Mix: regola il mix del segnale audio proveniente dagli ingressi (Direct) e dell'uscita audio del
computer (USB) che sara inviato alle Uscite principali e alle Uscite cuffie.

Nota bene: quando impostato su Direct, il canale sinistro sara la somma degli Ingressi 1,3,5¢e 7 e il
canale destro sara la somma degli Ingressi 2, 4, 6 e 8. Si possono sommare i canali destro e sinistro
(per sentire tutti gli ingressi come un unico segnale mono) premendo il tasto Direct Monitor.

Questa manopola & utile per gestire la “latenza” quando si registra nel DAW. La latenza ¢ il ritardo che
si pud avere tra il suono in ingresso (lo strumento suonato, il canto, ecc.) e il suono in uscita (quando si
sente nel DAW).

La latenza dipende spesso dalla configurazione della “dimensione del buffer”, che si trova solitamente
nel menu Preferiti, Opzioni o Configurazione Dispositivo del proprio DAW. A dimensioni di buffer
maggiore corrisponde solitamente una latenza superiore. In alcuni casi, un buffer di piccole dimensioni
pud consumare molta CPU del computer e pud provocare problemi di audio. Per impedire questi
problemi audio bisogna utilizzare un'impostazione piu elevata del buffer e questo pud portare a una
latenza.

In caso di latenza durante la registrazione, regolare la manopola verso la posizione diretta Direct per
aumentare la miscela di audio non elaborato proveniente dagli ingressi e direttamente alle uscite
principali e cuffie. In questo modo sara possibile sentire I'audio in arrivo dagli ingressi senza latenza,
potendo comunque sentire I'audio proveniente dal DAW. Al momento di ascoltare la riproduzione,
girare la manopola su "USB".

Se il computer € abbastanza potente, si pud impostare la dimensione del buffer nel DAW a un livello
sufficientemente basso da non dover mai sentire il segnale audio diretto proveniente dagli ingressi. In
questo caso, impostare la manopola Monitor Mix su USB per monitorare solo I'uscita audio del DAW.



10.

11.
12.

Selettore Direct Monitor: lasciare questo interruttore in posizione sollevata (il LED blu Stereo & acceso) per
monitorare il segnale di ingresso diretto con gli Ingressi 1, 3, 5 e 7 nel canale sinistro e gli Ingressi 2, 4,6 ¢ 8
nel canale destro. Cio e utile se si desidera monitorare direttamente un impianto mic stereo quale ad esempio
un segnale stereo proveniente da una tastiera o da microfoni alti per batteria. Collocare l'interruttore in
posizione premuta (LED verde Mono acceso) per monitorare il segnale di ingresso diretto con tutti gli ingressi
sommati e udibili equamente su ciascun lato. Cio & utile per il monitoraggio del segnale di una chitarra o di un
mic vocale. Questo interruttore non influisce sulla riproduzione del DAW o sul modo in cui il suono viene in esso
registrato; influisce unicamente sul modo in cui si sente il segnale a livello delle uscite cuffia (quando il
Selettore fonte cuffia &€ impostato su 1/2, e il Monitor Mix & impostato su qualsiasi cosa oltre a USB) e uscite
monitor.

Selettore fonte cuffia: questi interruttori selezionano quali uscite (a livello del pannello posteriore) vengono
inoltre inviate alle uscite cuffie: Uscite Main 1-2 (1/2) o Uscite 3-4 (3/4).

Uscite cuffie (pannello anteriore): collegare cuffie TRS da 1/4" (6,35 mm) a queste uscite. Il mix che si sente da
queste uscite sara determinato dal Selettore fonte cuffie, dalla manopola Monitor Mix, dal selettore Direct
Monitor e dalla manopola Volume cuffie associata.

Volume cuffie (pannello anteriore): regola il volume di uscita delle uscite cuffie.

Ingressi strumenti (5-6) (pannello anteriore): collegare una chitarra con un pickup passivo o un altro segnale
ad alta impedenza a questo ingresso servendosi di un cavo TS da 1/4" (6,35 mm). Visualizzare i livelli del
segnale di ingresso con i misuratori a LED (Ingressi 5-6).

Pannello posteriore

Alimentazione: collegare I’adattatore di
alimentazione in dotazione a questo ingresso.
Servirsi del tasto di alimentazione per
accendere e spegnere I'AIR 192[14.

Porta USB (tipo C): questo collegamento
consente di inviare audio e dati MIDI da/a un
computer. Servirsi dei cavi da USB-C-a-USB-C
o da USB-C-a-USB-A in dotazione per
collegare I'AIR 192[14 al computer. L'AIR 192|14
richiede un collegamento USB 2.0 (o superiore).

Uscita MIDI: servirsi dell’adattatore 1/8" (3,5 mm) a MIDI in dotazione e di un cavo MIDI standard a cinque poli
per collegare questa uscita MIDI all’ingresso MIDI di un dispositivo MIDI esterno (ad esempio un sintetizzatore,
un sequenziatore, una drum machine, ecc.).

Importante: Non collegare dispositivi audio (cuffie, monitor, ecc.) a questa uscita. Servirsi unicamente
dell’adattatore 3,5 mm-MIDI in dotazione per collegare i dispositivi MIDI.

Ingresso MIDI: servirsi dell’adattatore 1/8" (3,5 mm) a MIDI in dotazione e di un cavo MIDI standard a cinque
poli per collegare questo ingresso MIDI all’'uscita MIDI di un dispositivo MIDI esterno (ad esempio un controller
MIDI).

Importante: Non collegare dispositivi audio (cuffie, monitor, ecc.) a questo ingresso. Servirsi unicamente
dell’adattatore 3,5 mm-MIDI in dotazione per collegare i dispositivi MIDI.

Uscite (3-4): servirsi di cavi TRS standard da 1/4” (6,35 mm) per collegare queste uscite di linea a un
amplificatore cuffie, processori di segnale esterni quali un compressore, ecc. | relativi livelli sono
automaticamente +4 dBu.

Uscite principali (1-2): servirsi di cavi TRS standard da 1/4" (6,35 mm) per collegare queste uscite a monitor,
impianto di amplificazione, ecc. Il mix che si sente da queste uscite sara determinato dalla manopola Monitor
Mix e dal tasto Direct Monitor. Il livello di queste uscite & controllato dalla manopola Monitor Level.

Ingressi Linea (7-8): collegare mixer e altri dispositivi a livello di linea a questi ingressi servendosi di cavi
standard TRS da 1/4" (6,35 mm). Visualizzare i livelli del segnale di ingresso con i misuratori a LED (Ingressi
7-8).

Ingressi combo (1-4): collegare microfoni, una chitarra o un basso con pickup attivo o altri dispositivi a livello
di linea a questi ingressi. Per i microfoni, servirsi di un cavo XLR o TRS da 1/4” (6,35 mm). Per una chitarra o un
basso con pickup attivo, servirsi di un cavo TS standard da 1/4” (6,35 mm). Per segnali a livello di linea, servirsi
di un cavo TRS da 1/4". Visualizzare i livelli del segnale di ingresso con i misuratori a LED (Ingressi 1-4).

Slot per lucchetto Kensington: servirsi di questa apertura per lucchetto Kensington per fissare I'AIR 192|14 a
un tavolo o ad altre superfici.
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Benutzerhandbuch (Deutsch)

Vielen Dank fur den Kauf des AIR 192|14. Wir von M-Audio wissen, wie wichtig Ihnen die Musik ist.
Darum entwerfen wir unsere Gerate stets nur mit einem einzigen Ziel vor Augen: Ihre Performance so
gut wie mdéglich zu unterstitzen.

Lieferumfang

AIR 192|14

Netzteil

USB-C zu USB-C Kabel
USB-C zu USB-A Kabel

(2) 3,5 mm zu MIDI-Adapter
Software Download-Karten
Benutzerhandbuch

Sicherheitshinweise und Garantieinformationen

Kundendienst

Fir die neuesten Informationen zu diesem Produkt (Dokumentation, technische Daten,
Systemanforderungen, Informationen zur Kompatibilitat etc.) und zur Produktregistrierung besuchen
Sie bitte: m-audio.com.

Fir zusatzlichen Produkt-Support besuchen Sie m-audio.com/support.

Audio-Setup

Windows-Benutzer: Installieren Sie die Treiber bevor Sie AIR 19214 mit Inrem Computer verbinden:

1. Besuchen Sie m-audio.com/drivers und laden Sie die neuesten AIR 192|14-Treiber fur Ihr
Betriebssystem herunter.

N

Offnen Sie die heruntergeladene Datei und doppelklicken Sie auf die Treiber-Installationsdatei.

«

Lesen Sie die Endbenutzer-Lizenzvereinbarung, aktivieren Sie das Kontrollkdstchen
"Zustimmung" und klicken Sie auf Weiter, um fortzufahren.

4. Klicken Sie auf Installieren, um die Installation zu starten. Sie werden wahrend der Installation
moglicherweise aufgefordert, AIR 19214 an lhren Computer anzuschlieBen. Bei moglichen
weiteren Systemmeldungen wahrend der Installation klicken Sie auf Installieren.

5. Sobald die Installation abgeschlossen ist, klicken Sie auf Fertigstellen.

Um den Windows-Treiber zu verwenden, 6ffnen Sie das M-Audio AIR 19214 Control Panel. Hier
koénnen Sie Ihre Bevorzugte PuffergréBe und Sample-Rate einstellen.


http://www.m-audio.com
http://www.m-audio.com/support
http://www.m-audio.com/drivers

Um AIR 192|114 als Standard-Wiedergabegerat einzustellen, folgen Sie den nachstehenden
Anweisungen je nach Betriebssystem lhres Computers.

Windows:

1.

SchlieBen Sie Ihr AIR 192|14 mit dem mitgelieferten USB-Kabel an lhren Computer an. Driicken
Sie Netzschalter, um AIR 192|14 einzuschalten.

2. Suchen Sie das Lautsprechersymbol fur die Lautstarke in der Taskleiste. Klicken Sie mit der
rechten Maustaste auf den Lautsprecher und wahlen Wiedergabegerite.
Klicken Sie auf Startmenii > Systemsteuerung (oder Einstellungen > Systemsteuerung in der
klassischen Ansicht) > Hardware und Sound > Sound.

3. In der Windows-Systemsteuerung fir Sound wahlen Sie die Registerkarte Wiedergabe und
wahlen AIR 192[14 als Standard-Gerét aus.

4. Klicken Sie auf die Registerkarte Aufnahme und wahlen Sie AIR 192|14 als Standard-Gerat aus.

5. Klicken Sie in der rechten unteren Ecke auf Eigenschaften.
Klicken Sie im neuen Fenster auf die Registerkarte Erweitert und wahlen Sie 2-Kanal, 24 Bit,
48000 Hz (Studio-Qualitat) als Standardformat aus.

7. Deaktivieren Sie beide Kontrollkastchen unter Exklusivmodus.

8. Klicken Sie auf OK, um das Fenster Eigenschaften zu schlieBen.

9. Kilicken Sie auf OK, um das Fenster Sound zu schlieBen.

macOS:

1. SchlieBen Sie lhr AIR 192|14 mit dem mitgelieferten USB-Kabel an lhren Computer an. Driicken
Sie Netzschalter, um AIR 192|14 einzuschalten.

2. Wahlen Sie Anwendungen > Dienstprogramme > Audio-MIDI-Setup.

3. Wahlen Sie im Fenster Audiogeréte die Option AIR 192[14 in der linken Spalte aus.

4. Klicken Sie mit der rechten Maustaste auf AIR 192|14, und wéhlen Sie Dieses Gerat fiir
Soundeingabe verwenden.

5. Klicken Sie mit der rechten Maustaste auf AIR 19214 und wahlen Sie Dieses Gerat fiir
Soundausgabe verwenden.

6. SchlieBen Sie das Fenster Audio-MIDI-Setup.
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Einrichten von AIR 192|14 mit lhrer Software

AIR 192|8 mit MPC-Beats einrichten

»>wd o~

SchlieBen Sie lhr AIR 192|14 mit dem mitgelieferten USB-Kabel an Ihren Computer an.
Offnen Sie MPC Beats.
Gehen Sie zu Edit > Preferences....

Fiir Windows-Anwender: Wahlen Sie im Audio-Fenster die Option ASIO im Dropdown-Meni
Audio Device Type aus. Im Dropdown-Menu Device wahlen Sie die Option AIR 192[14.

Fiir macOS-Anwender: Wahlen Sie im Audio-Fenster die Option AIR 192|14 unter den Output -
und Input-Dropdown-MenUs aus.
Hinweis: Moglicherweise miussen Sie Ihr Projekt speichern und neu starten.

Wahlen Sie lhre Sample Rate aus und klicken Sie auf OK, um das Einstellungen-Fenster zu
schlieBen.

Sie koénnen nun Audiospuren hinzufiigen, um Audiosignale von den mit den AIR 192[14-
Eingéngen verbundenen Quellen zu empfangen/senden und die aufgenommenen Signale zuriick
an die AIR 192|14-Ausgénge zu streamen.

So richten Sie den AIR 192|14 mit Ableton Live Lite

I

6.

SchlieBen Sie Ihren AIR 192|14 mit dem mitgelieferten USB-Kabel an lhren Computer an.
Offnen Sie Ableton Live Lite.

Wechseln Sie zur Registerkarte Einstellungen > Audio.

Klicken Sie auf Driver Type, um CoreAudio (Mac) oder ASIO (Windows) auszuwahlen.
Wahlen Sie im Bereich Eingabe- und Ausgabekonfiguration die Option AIR 192|14.
Wahlen Sie lhre Samplerate und schlieBen Sie das Fenster Audio-Einstellungen.

Sie kénnen jetzt Tracks zum Senden und Empfangen von Audio und MIDI von Quellen hinzufligen,
die an die AIR 192|14-Eingange angeschlossen sind, und die aufgenommenen Audiosignale Uber die
AIR 192|14-Ausgéange wiedergeben.
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Anschlussdiagramm
Teile, die nicht unter Einfiihrung > Lieferumfang angegeben sind, sind separat erhaltlich.
Beispiel 1

Aktivemonitore Mikrofone

Computer

Ober-/Vorderseite
Elektrische

Gitarren

Kopfhorer

Beispiel 2

Aktivemonitore Mikrofone

Ober-/Vorderseite

Elektrische

Gitarren
728

Kopfhorerverstérker Kopfhorer

Beispiel 3

Aktivemonitore Mikrofon

Computer Ober-/Vorderseite

Elektrische
Gitarren

Kopfhorer
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Oberseite

30

Power-Taste: Dricken Sie diese Taste, um
den AIR 192|14 ein- oder auszuschalten. Die
Power-LED unter dieser Taste leuchtet auf,
wenn das Gerét eingeschaltet ist.

Input Gain: Passt den Verstérkungsfaktor
des Eingangs an. Stellen Sie diesen Regler
so ein, dass die entsprechende LED-
Anzeige (unterhalb des Reglers) wahrend
der Performance einen ,gesunden“ Pegel
anzeigt (gelbe LED leuchtet). Der Pegel sollte
jedoch nicht so hoch sein, dass die Anzeige
»Clippt“ (rote LED) und Pegelspitzen erreicht
werden, die das Audiosignal verzerren.

LED-Anzeigen (Eingdnge 1-6): Zeigt den
Eingangssignalpegel aus den Combo-

Eingéngen und Instrumenten-Eingéngen. @ m m @ @ @

LED-Anzeigen (Eingdnge 7-8): Zeigt den Eingangssignalpegel aus den Line-Eingdngen an. Diese
LEDs leuchten griin, wenn ein Signal Uber -20 dBFS vorhanden ist bzw. leuchten rot, wenn das Signal
,Clippt“ oder Spitzenwerte aufweist.

+48 V (Phantom Power) Schalter: Diese Schalter aktivieren und deaktivieren die Phantomspeisung fiir
Combo-Eingdnge 1-2 oder 3-4. Bei Aktivierung liefert die Phantomspeisung +48 Volt an die
ausgewdhlten Eingdnge. Bitte beachten Sie, dass die meisten dynamischen Mikrofone und
Bandchenmikrofone keine Phantomspeisung bendétigen. Die meisten Kondensatormikrofone tun dies
jedoch. Schlagen Sie im Handbuch lhres Mikrofons nach, um herauszufinden, ob es eine
Phantomspeisung benétigt. Beachten Sie, daB Phantomspeisung manche Bandchenmikrofone
beschédigen kann! Konsultieren Sie das Handbuch des Mikrofons.

Monitorpegel: Passt die Ausgangslautstérke der Hauptausgéange an, welche mit den Aktivboxen oder
dem Verstérker verbunden sein sollten.

Monitor Mix: Passt den Mix aus dem Audiosignal von lhren Eingdngen (Direct) und dem Audio-
Ausgang des Computers (USB) an, der an die Hauptausgénge und die Kopfhérerausgange gesendet
wird.

Hinweis: Bei der Einstellung Direct summiert der linke Kanal die Eingdnge 1, 3, 5 und 7 und der rechte
Kanal die Eingédnge 2, 4, 6 und 8. Sie konnen diese Kandle links und rechts summieren (um alle
Eingange als einziges summiertes Monosignal zu héren), indem Sie die Taste Direct Monitor in die
heruntergedrickte Position bringen.

Dieser Regler eignet sich fir den Umgang mit der ,Latenz“, wenn Sie in Ihrer DAW aufnehmen. Die
Latenz ist eine Signalverzdgerung, die zwischen dem eingehenden Signal (wenn Sie lhr Instrument
spielen, singen usw.) und dem ausgehenden Signal (wenn Sie den Ton in lhrer DAW héren) auftreten
kann.

Die Latenz ist oft das Ergebnis der eingestellten ,PuffergroBe“. Diese Einstellung befindet sich in der
Regel im Einstellungen- oder Optionenmeni lhrer DAW oder im Geréte-Setup. Hohere PuffergréBen
fuhren generell zu gréBerer Latenz. In manchen Féllen kann eine niedrigere PuffergroBeneinstellung die
CPU-Kapazitat lhres Computers stark in Anspruch nehmen und Tonstérungen verursachen. Um diese
Tonstérungen zu vermeiden, missen Sie eine hohere Puffereinstellung verwenden. Diese kann zu
Latenz fiihren.

Wenn es beim Aufnehmen zu Latenzzeiten kommt, drehen Sie den Regler in die Position Direct, um
den Mix von nicht verarbeiteten Audiosignalen von lhren Eingangen direkt an lhre Hauptausgénge und
Ihre Kopfhorerausgénge zu erhdhen. Auf diese Weise kdnnen Sie die eingehenden Audiosignale von
lhren Eingdngen ohne Latenz héren und dabei trotzdem das Audiosignal von Ihrer DAW héren. Wenn
Sie sich die Aufnahme anhéren, stellen Sie den Regler ganz auf die Position USB.

Wenn lhr Computer Uber die ndtige Rechenleistung verfligt, kdnnen Sie die PuffergréBeneinstellung in
Ihrer DAW eventuell so niedrig einstellen, dass Sie die direkten Audiosignale von lhren Eingéngen nie
verwenden mussen. In diesem Fall stellen Sie den Regler Monitor Mix ganz auf die Position USB, um
nur die Audioausgabe Ihrer DAW zu Uberwachen.

«@
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10.

11.
12.

Direct Monitor-Wahlschalter: Belassen Sie diesen Schalter in der angehobenen Position (blaue Stereo-LED
leuchtet), um das direkte Eingangssignal mit den Eingédngen 1, 3, 5 und 7 am linken Kanal und die Eingénge 2,
4, 6 und 8 am rechten Kanal zu Uberwachen. Dies ist nutzlich, wenn Sie ein Stereomikrofon-Setup, wie ein
Stereosignal von einem Keyboard oder Overhead-Drum-Mikrofonen direkt Gberwachen moéchten. Bringen Sie
diesen Schalter in die heruntergedriickte Position (griine Mono-LED leuchtet), um das direkte Eingangssignal
mit allen Eingédngen in Summe und gleichmaBig auf beiden Seiten zu Uberwachen. Dies ist nitzlich fir die
Uberwachung eines Gitarren- oder Gesangsmikrofonsignals. Dieser Schalter hat keinen Einfluss auf die DAW-
Wiedergabe oder darauf, wie Ihre Audiosignale in Ihrer DAW aufgezeichnet werden; er hat lediglich einen
Einfluss darauf, wie Sie das Eingangssignal tUber die Kopfhorerausgénge und die Monitor-Ausgangehdren
(wenn der Source-Schalter der Kopfhorer auf 1/2 und der Monitor Mix auf eine andere Einstellung als USB
eingestellt ist).

Source-Schalter der Kopfhérer: Mit diesem Schalter wéhlen Sie, welche Ausgénge (auf der Riickseite) an die
Kopfhorerausgange gesendet werden: Hauptausgéange 1-2 (1/2) oder Ausgénge 3-4 (3/4).
Kopfhorerausgénge (Vorderseite): SchlieBen Sie 6,35 mm TRS-Kopfhoérer an diese Ausgange an. Der Mix, den
Sie von diesen Ausgéngen horen, wird vom Source-Schalter der Kopfhérer, Monitor Mix-Regler, Direct
Monitor-Wahlschalter und dem zugewiesenen Kopfhérerpegelregler bestimmt.

Kopfhorerlautstarke (Vorderseite): Regelt die Lautstérke des Kopfhorerausgangs.

Instrumenteneingéange (5-6) (Vorderseite): SchlieBen Sie eine Gitarre mit einem passiven Tonabnehmer oder
einem anderen hochohmigen Signal an diese Eingdnge mit einem 6,35 mm TS-Kabel an. Prifen Sie den
Eingangspegel mit der LED-Anzeige (Eingange 5-6).

Riickseite

Stromversorgung: SchlieBen Sie das
mitgelieferte Netzteil an diesen Eingang an.
Verwenden Sie den Netzschalter, um das AIR
192|14 ein- oder auszuschalten.

USB-Port (Typ C): Uber diesen Anschluss
kénnen Sie Audio- und MIDI-Daten an und vom
Computer senden. Verwenden Sie die im
Lieferumfang enthaltenen USB-Cauf-USB-C oder
USB-C-auf-USB-A-Kabel, um Ihr AIR 192[14 an
einen Computer anzuschlieBen. AIR 19214
bendtigt einen USB 2.0-Anschluss (oder hoher).
MIDI-Ausgang: Verwenden Sie den mitgelieferten 3,5 mm-MIDI-Adapter und ein handelslbliches, flinfpoliges
MIDI-Kabel, um diesen MIDI-Ausgang mit dem MIDI-Eingang eines externen MIDI-Geréts zu verbinden (z. B.
einem Synthesizer, Sequenzer, Drum-Computer etc.).

Wichtig: SchlieBen Sie keine Audio-Geréte (z.B. Kopfhorer, Monitore etc.) an die 3,5 mm MIDI-Ausgang oder
MIDI-Eingang Buchsen an. Verwenden Sie ausschlieBlich die mitgelieferten 3,5 mm-MIDI-Adapter, um die
MIDI-Gerate zu verbinden.

MIDI-Eingang: Verwenden Sie den mitgelieferten 3,5 mm-MIDI-Adapter und ein handelstbliches, fiinfpoliges
MIDI-Kabel, um diesen MIDI-Eingang mit dem MIDI-Ausgang eines externen MIDI-Geréats zu verbinden (z. B.
einem anderen MIDI-Controller).

Wichtig: SchlieBen Sie keine Audio-Geréte (z.B. Kopfhorer, Monitore etc.) an die 3,5 mm MIDI-Ausgang oder
MIDI-Eingang Buchsen an. Verwenden Sie ausschlieBlich die mitgelieferten 3,5 mm-MIDI-Adapter, um die
MIDI-Gerate zu verbinden.

Ausgénge (3-4): Verwenden Sie standardméBige 6,35 mm TRS-Kabel, um diese Line-Ausgénge mit einem
Kopfhorerverstarker, externen Signalprozessoren wie einem Kompressor usw. zu verbinden. lhre Pegel sind
automatisch +4 dBu.

Hauptausgénge (1-2): Verwenden Sie handelslbliche 6,35 mm TRS-Kabel, um diese Ausgédnge an
Aktivmonitore, ein Verstarkersystem oder Ahnliches anzuschlieBen. Der Mix, den Sie von diesen Ausgdngen
héren, wird vom Monitor Mix-Regler und der Direct Monitor-Taste bestimmt. Die Lautstarke dieser Ausgénge
wird Uber den Monitorpegelregler kontrolliert.

Line-Eingénge (7-8): SchlieBen Sie Mixer und andere Line-Level-Gerate an diese Eingédnge an, indem Sie
standardméBige 6,35 mm TRS-Kabel verwenden. Prifen Sie den Eingangspegel mit der LED-Anzeige
(Eingange 7-8).

Combo-Eingénge (1-4): SchlieBen Sie ein Mikrofon, eine Gitarre, einen Bass mit einem aktiven Pickup oder ein
Line-Level-Gerat an diese Eingédnge an. Fir Mikrofone verwenden Sie ein XLR- oder 6,35 mm TRS-Kabel.
Verwenden Sie ein 6,35 mm TS-Kabel fur eine Gitarre oder einen Bass mit einem aktiven Pickup. Fir Line-
Signale verwenden Sie ein 6,35 mm TRS-Kabel.) Priifen Sie den Eingangspegel mit der LED-Anzeige
(Eingdnge 1-4).

Kensington Lock Slot: Sie kénnen diesen Kensington Lock Sicherheits-Slot verwenden, um das AIR 192|14 an
einem Tisch oder einer anderen Oberflache zu befestigen.
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Appendix (English)

All specifications are measured at 20 kHz bandwidth.

Mic Inputs 1-4 (balanced XLR)

Dynamic Range 113 dB (A-weighted)

THD+N 0.001% (1 kHz, +4 dBu, -1 dBFS)

Frequency Response 20 Hz - 20 kHz (+/-0.2 dB)

Preamp EIN -137 dBu (40 Q source, A-weighted)
-129 dBu (150 Q source, unweighted)

Max Input Level +14 dBu

Gain Range 62 dB

Line Inputs 1-4 (balanced 1/4" TRS)

Dynamic Range 113 dB (A-weighted)

THD+N 0.001% (1 kHz, +4 dBu, -1 dBFS)
Frequency Response 20 Hz - 20 kHz (+/-0.1 dB)

Max Input Level +30 dBu

Gain Range 61 dB

Inst Inputs 5-6 (unbalanced 1/4" TS)

Dynamic Range 110 dB (A-weighted)

THD+N 0.001% (1 kHz, +4 dBu, -1 dBFS)
Frequency Response 20 Hz - 20 kHz (+/-0.1 dB)

Max Input Level +16 dBu

Gain Range 59 dB

Input Impedance ~1 MQ

Fixed Line Inputs 7-8 (balanced 1/4" TRS)

Dynamic Range 113 dB (A-weighted)
THD+N 0.001% (1 kHz, +4 dBu, -1 dBFS)
Frequency Response 20 Hz - 20 kHz (+/-0.1 dB)

Max Input Level +17 dBu




Line Outputs 1-2 (balanced 1/4" TRS)

Dynamic Range

112 dB (A-weighted)

THD+N

0.002% (1 kHz, -1 dBFS)

Frequency Response

20 Hz - 20 kHz (+/-0.2 dB)

Maximum Output Level

+17 dBu

Fixed Line Outputs 3—4 (balanced 1/4" TRS)

Dynamic Range

113 dB (A-weighted)

THD+N

0.002% (1 kHz, -1 dBFS)

Frequency Response

20 Hz - 20 kHz (+/-0.2 dB)

Maximum Output Level

+17 dBu

Headphone Outputs (stereo 1/4")

Dynamic Range

111 dB (A-weighted, 32 Q load)

THD+N

0.002% (1 kHz, -1 dBFS, 10 mW/channel into 32 Q load)

Frequency Response

20 Hz - 20 kHz (+/-0.2 dB)

Maximum Power Delivered

160mW (<1% THD, 32 Q load)

Maximum Output Level

+15 dBu (unloaded)

Impedance Range

32 Q-600Q

;
General

Other Connectors

Power Adapter

Dimensions
(width x depth x height)

Weight

1) 1/8” (3.5 mm) MIDI input
1) 1/8” (3.5 mm) MIDI output
1) USB Type-C port

1) Power adapter input

—_~ e~~~

12 V DC, 2 A, center-positive (included)

10.2"x 7.3" x 3.6"
259 x 186 x 91.4 mm

3.9 Ibs.
1.8 kg

Specifications are subject to change without notice.

Trademarks & Licenses

M-Audio and AIR Music Tech are registered trademarks of inMusic Brands, Inc., registered in the U.S. and

other countries.

Ableton is a trademark of Ableton AG.
Kensington and the K & Lock logo are registered trademarks of ACCO Brands.
macOS is a trademark of Apple Inc., registered in the U.S. and other countries.

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
All other product names, company names, trademarks, or trade names are those of their respective owners.
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